# Contents

1 Introduction............................................................................................................... 5

  1.1 Structure of the document..................................................................................... 5
     1.1.1 Identification of the danger levels................................................................. 5
     1.1.2 Formats and symbols used.............................................................................. 5

  1.2 General information on the use of GALAXIS .................................................... 6

  1.3 Limited functionality of GALILEOS model version GAX5.............................. 7

  1.4 Functionality of ORTHOPHOS XG 3D............................................................... 7

2 Technical description................................................................................................ 9

  2.1 Sirona Reconstruction Server (RCU) ................................................................. 9

  2.2 GALAXIS PC...................................................................................................... 9

  2.3 Network............................................................................................................. 9

3 Starting GALAXIS..................................................................................................... 10

4 Closing GALAXIS .................................................................................................... 11

5 Creating 3D X-ray images........................................................................................ 12

6 Workspaces.............................................................................................................. 13

  6.1 Explanation ...................................................................................................... 13

  6.2 Structure........................................................................................................... 13
     6.2.1 Toolbar ...................................................................................................... 13
     6.2.2 Views......................................................................................................... 16
     6.2.3 Tab............................................................................................................. 16
     6.2.4 What is the examination window?................................................................. 16

  6.3 "Panoramic view" workspace .............................................................................. 17

  6.4 "MPR/Radiology" workspace.............................................................................. 18

  6.5 "Ceph p.a./a.p." workspace................................................................................ 19

  6.6 "Ceph lateral" workspace ................................................................................ 20

  6.7 "Detail" workspace .......................................................................................... 21

7 Views........................................................................................................................ 23

  7.1 Panoramic view ................................................................................................ 23
     7.1.1 Examination window ................................................................................... 23
7.2 3D view ........................................................................................................ 25
  7.2.1 3D view in the workspaces ................................................................ 25
  7.2.2 Interaction .............................................................................................. 26
7.3 Longitudinal view ............................................................................................ 26
7.4 Transversal view ............................................................................................. 28
7.5 Axial plane ...................................................................................................... 29
7.6 Coronal plane .................................................................................................. 30
7.7 Sagittal plane .................................................................................................. 30

8 Functions ........................................................................................................... 32
  8.1 2D snapshot .................................................................................................. 32
    8.1.1 Complete examination ........................................................................ 32
    8.1.2 Individual view .................................................................................... 32
  8.2 Printing .......................................................................................................... 33
    8.2.1 Complete examination ........................................................................ 33
    8.2.2 Individual view .................................................................................... 33
  8.3 Navigating through slices ............................................................................ 33
  8.4 Standard mouse pointer .............................................................................. 34
  8.5 Mouse adjuster: Adjust brightness and contrast with mouse ...................... 34
  8.6 Moving the view ........................................................................................... 35
  8.7 Positioning the crosshair with a single click .............................................. 35
  8.8 Resetting the displays .................................................................................. 36
  8.9 Measurements ............................................................................................... 36
    8.9.1 Measuring lengths ............................................................................... 36
    8.9.2 Measure angles .................................................................................... 37
    8.9.3 Root canal measurement ..................................................................... 38
  8.10 Reconstructing a panoramic view ............................................................... 39
  8.11 Zoom function ............................................................................................. 42
  8.12 Transfer function ......................................................................................... 42
  8.13 Findings-based work ................................................................................... 43
    8.13.1 Explanation ......................................................................................... 43
    8.13.2 Creating a new finding ....................................................................... 43
    8.13.3 Selecting a finding ............................................................................... 44
    8.13.4 Changing the position of a finding ..................................................... 44
    8.13.5 Editing a finding .................................................................................. 44
    8.13.6 Deleting a finding ............................................................................... 45
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.13.7 Creating a report</td>
<td>45</td>
</tr>
<tr>
<td>8.14 Reconstructing a &quot;Ceph p.a./a.p.&quot; view</td>
<td>45</td>
</tr>
<tr>
<td>8.15 Reconstructing a lateral Ceph view</td>
<td>47</td>
</tr>
<tr>
<td>8.16 Creating a detail volume</td>
<td>48</td>
</tr>
<tr>
<td>8.17 Showing and hiding orientation lines and findings</td>
<td>49</td>
</tr>
<tr>
<td>8.18 Settings</td>
<td>49</td>
</tr>
<tr>
<td>9 Create GALILEOS Viewer CD</td>
<td>51</td>
</tr>
</tbody>
</table>
1 Introduction

Contents of this manual

The present manual provides instructions and information on how to use the GALAXIS software:

- Comprehensive instructions on use of the software.
- An introduction to the acquisition technique.
- Possibilities for visualizing and analyzing digital 3D X-ray images.

GALILEOS Viewer

The manual also describes the functionality of the GALILEOS Viewer. Not all GALAXIS functions are available in the GALILEOS Viewer.

1.1 Structure of the document

1.1.1 Identification of the danger levels

To prevent personal injury and material damage, please observe the warning and safety information provided in this document. Such information is highlighted as follows:

- **DANGER**
  An imminent danger that could result in serious bodily injury or death.

- **WARNING**
  A possibly dangerous situation that could result in serious bodily injury or death.

- **CAUTION**
  A possibly dangerous situation that could result in slight bodily injury.

- **NOTICE**
  A possibly harmful situation which could lead to damage of the product or an object in its environment.

- **IMPORTANT**
  Application instructions and other important information.

**Tip:** Information on making work easier.

1.1.2 Formats and symbols used

The formats and symbols used in this document have the following meaning:
1.2 General information on the use of GALAXIS

Intended use

GALAXIS is a software for dental practices and clinics that enables the preparation of three-dimensional volume reconstructions of the maxillofacial region. GALAXIS is a component of the following 3D X-ray systems from SIRONA:

- GALILEOS dental volume tomograph
- ORTHOPHOS XG 3D

The volume reconstructions can be used both for planning and for diagnostic purposes with the help of GALAXIS.

- For example for oral and maxillofacial surgery, plastic surgery and ENT medicine.

Systems with GALAXIS

A system with GALAXIS comprises:

- 3D X-ray unit from SIRONA
  The X-ray unit produces two-dimensional images of the head region via a cone beam with a rotation sequence.

- RCU (Reconstruction Control Unit)
  Reconstruction software converts the two-dimensional images into a three-dimensional volume reconstruction. The RCU also manages the software licenses.

- GALAXIS work station(s)
  Enables the creation of a new three-dimensional volume reconstruction (activation on the X-ray unit to create a new exposure and to convert this exposure into a three-dimensional volume reconstruction on the RCU).
  The GALAXIS software can be used to display and process the three-dimensional volume reconstructions. Management of the three-dimensional volume reconstructions (storage in and access to the SIDEXIS database).
Introduction

1.3 Limited functionality of GALILEOS model version GAX5

- SIDEXIS database
  Storage of three-dimensional volume reconstructions.

IMPORTANT INFORMATION

⚠️ CAUTION
Compliance with national regulations
Make sure that the use of GALAXIS is compliant with all relevant national laws and regulations.

⚠️ CAUTION
Restrictions imposed by U.S. American Federal Law
Based on US federal law, the sale of this unit to or by order of physicians, dentists or other trained medical personnel is subject to certain limitations.

Add-on modules

The functionality of GALAXIS can be extended by installing add-on modules (e.g. "GALILEOS Implant").

Such add-on modules are supplied with a separate user manual and therefore are not further explained in this manual.

NOTICE

In case of problems with add-on modules, please contact the corresponding software provider.

1.3 Limited functionality of GALILEOS model version GAX5

Explanation

GALAXIS has a limited functionality in connection with model version GAX5.

Version GAX5 is a component of the "GALILEOS Compact" package.

Identification

All functions not available for model version GAX5 are marked accordingly with a special logo in this document.

1.4 Functionality of ORTHOPHOS XG 3D

Explanation

GALAXIS has an adapted functionality in connection with the ORTHOPHOS XG 3D.
Identification

All functions not available for the ORTHOPHOS XG 3D are marked accordingly with a special logo in this document.
2 Technical description

2.1 Sirona Reconstruction Server (RCU)

Minimum requirements for the RCU

- Processor: at least 2 GHz dual-core CPU
- RAM: at least 4 GB RAM
- Hard disk: > 500 MB
- Drive: CD/DVD writer
- Operating system: Windows XP Professional Service Pack 2 or newer
  - Windows 7 Professional (32-bit & 64-bit)
- Graphics system: > 512 MB, minimum resolution 1280x1024 pixels
- Screen: Suitable for diagnostic purposes
- Network connection: Network RJ45, 100 MBit/s (1 GBit/s recommended)

2.2 GALAXIS PC

Minimum requirements for the PC used for the display GALAXIS

- Processor: at least 1.6 GHz dual-core CPU
- RAM: at least 2 GB RAM
- Hard disk: at least 5 GB
- Drives: CD/DVD writer
- Operating systems: Windows XP Professional Service Pack 3 or newer
  - Windows 7 Professional (32-bit & 64-bit)
- Graphics system: externally > 512 MB,
  - Minimum resolution 1280 x 1024 pixels
  - 16.7 mil. colors ("TrueColor")
- Screen: Suitable for diagnostic purposes
- Network connection: Network RJ45, 100 MBit/s (1 GBit/s recommended)

2.3 Network

Minimum requirements

- Infrastructure: Network RJ45, 100 MBit/s (1 GBit/s recommended)
Starting GALAXIS

Explanation

GALAXIS is started via SIDEXIS XG.

Prerequisites

In order to start GALAXIS, a 3D X-ray image must be opened in the SIDEXIS database first.

Simplified call method

1. Start SIDEXIS XG.
   - The GALAXIS button is displayed as not active (faded) on the toolbar of the SIDEXIS XG desktop.
2. Select a patient with an existing 3D X-ray image.
3. Select a 3D X-ray image.
   - The selected 3D X-ray image is displayed in SIDEXIS. The GALAXIS button is displayed as active.
4. Press the GALAXIS button.
   - GALAXIS and the selected 3D X-ray image are loaded.

Alternative start options

The following alternative options exist for starting GALAXIS via the the SIDEXIS XG desktop instead of by pressing the GALAXIS button:

- Via context menu: Select the "3D" menu option.
- Via the "3D" button in the upper right-hand corner of the 3D image.

NOTICE

If no 3D X-ray exposures are available, you must create a 3D X-ray exposure first (see the chapter titled "Creating a 3D exposure").
4 Closing GALAXIS

Closing

➢ Go to the "Workspace" menu bar and select the "Exit" menu option.

➢ GALAXIS is then closed and the SIDEXIS XG desktop appears.
5 Creating 3D X-ray images

Explanation

The 3D X-ray exposures are created via the SIDEXIS XG exposure readiness function and managed in the SIDEXIS database parallel to other X-ray exposures (IO "Intraoral", XP "Panoramic", XC "Ceph", etc.). At the same time, the 3D X-ray images are stored on the "***3D***Image type tab card.

Required documentation

The operation of the SIDEXIS XG software is explained in the document entitled "SIDEXIS XG Operator's Manual".

Operation of the 3D X-ray device:

- For GALILEOS
  "GALILEOS Operating Instructions"
- For ORTHOPHOS XG 3D
  "ORTHOPHOS XG 3D Operating Instructions"

Creation

1. Start SIDEXIS XG (see document entitled "SIDEXIS XG Operator's Manual").
2. Select a patient.
3. Press the 3D Scan button.
   - The 3D exposure readiness dialog box opens.
4. Press the release button.
   - The image is created and the volume is reconstructed.

After a few minutes, the icon for the 3D X-ray image is displayed on the SIDEXIS XG desktop.

The 3D X-ray image is now managed in the SIDEXIS database in the same way as any other X-ray image.

⚠️ CAUTION

X-rays

Make sure that all locally applicable radiation protection regulations are observed! Also make sure that the application information provided in the "GALILEOS Operating Instructions" or the document entitled "ORTHOPHOS XG Operating Instructions" is observed (especially regarding patient positioning and the start of exposure)!
6 Workspaces

6.1 Explanation

Optimized workspaces are provided for different tasks.
A workspace shows several different views of various slices through the volume.
These views are interconnected via the examination window.

6.2 Structure

6.2.1 Toolbar

**Explanation**
The toolbar consists of buttons which contain graphic symbols (icons).
A function can be initiated by clicking one of these icons.
### Standard tools

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Standard mouse pointer [→ 34]</td>
</tr>
<tr>
<td>B</td>
<td>Enlarging [→ 42]</td>
</tr>
<tr>
<td>C</td>
<td>Reducing [→ 42]</td>
</tr>
<tr>
<td>D</td>
<td>Hand (move view) [→ 35]</td>
</tr>
<tr>
<td>E</td>
<td>Navigating into the volume [→ 33]</td>
</tr>
<tr>
<td>F</td>
<td>Navigating out of volume [→ 33]</td>
</tr>
</tbody>
</table>

### Diagnostic tools

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Open panoramic view [→ 23]</td>
</tr>
<tr>
<td>H</td>
<td>Length measurement [→ 36]</td>
</tr>
<tr>
<td>I</td>
<td>Print workspace [→ 33]</td>
</tr>
<tr>
<td>J</td>
<td>Create GALILEOS Viewer CD [→ 51]</td>
</tr>
</tbody>
</table>

6 Workspaces

6.2 Structure

Workspaces Sirona Dental Systems GmbH

Operator's Manual GALAXIS
### Evaluation tools

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>Adjusting the brightness</td>
</tr>
<tr>
<td>L</td>
<td>Create detail volume [→ 48]</td>
</tr>
<tr>
<td>M</td>
<td>Measuring angles [→ 37]</td>
</tr>
<tr>
<td>N</td>
<td>2D snapshot [→ 32]</td>
</tr>
<tr>
<td>O</td>
<td>Adjust contrast</td>
</tr>
</tbody>
</table>

#### Evaluation tools:

- **A** Create new finding (see section "Creating a new finding" [→ 43])
- **B** List of findings (list of created findings) (see section "Selecting a finding" [→ 44])
- **C** Copy current view for finding (see section "Changing the position of a finding" [→ 44])
- **D** Properties of finding (see section "Editing a finding" [→ 44])
- **E** Delete finding (see section "Deleting a finding" [→ 45])
- **F** Create report (see section "Creating a report" [→ 45])

**NOTE:** This function is only available with a current version of the REPORTER software.
6.2.2 Views

Explanation
Several different views are displayed in a single workspace.
- The currently active view, which can be recognized by its orange colored frame and letters, can be processed directly.
- The slice displayed in the active view is marked by a crosshair in all other views.

Selecting a view
➢ Click the desired view.
✓ The color of the view’s title bar then changes to indicate that the view is active.

6.2.3 Tab

Explanation
You can select different workspaces by clicking the corresponding tabs.

6.2.4 What is the examination window?

Explanation
The display in views is based on a single, three-dimensional vector point in the reconstructed volume.
- Various different slices of the volume are displayed starting from this vector point, depending on the view concerned.
- The vector point here is located in the crosshair for the respective slice axes.
  For this reason, the crosshair is always located in the same position in the volume in all views.
  Depending on the view type, the vector point is located either in the center of the view or in the examination window of the view.
  When the user navigates within a view or the examination window or through the slices, the slices are automatically adjusted in the other views.

Example:
If you, for example, move the examination window of the panoramic view, the transverse views, the longitudinal view and the curved line in the axial plane will all be altered accordingly.

NOTICE

Only one view can be active at any given time.
6.3 "Panoramic view" workspace

Explanation

After you start GALAXIS, the selected 3D X-ray image will be displayed in the classical panoramic view.

In addition to the panoramic view workspace, there is an additional workspace with both a panoramic and a 3D view.

NOTICE

ORTHOPHOS XG 3D only

Only a single region is displayed in a 3D image acquired with an ORTHOPHOS XG 3D!

Brief overview

In each view, the fine lines of the crosshair indicate the positions in the other views to which this corresponds.

Example:

- The horizontal line in the examination window shows the position in the axial plane. All views are linked in this way, making it easy for users to navigate.
- The axial slice also contains a curved line which indicates the position in the examination window.

Views

| A | Panoramic view [→ 23] |
| B | 3D view [→ 25] (Only in the "Panoramic view with 3D" workspace) |
6.4 "MPR/Radiology" workspace

Explanation

The Radiology workspace contains the three classical (axial, coronal and lateral) planes of the 3D volume as well as the 3D view.

NOTICE

ORTHOPHOS XG 3D only

Only a single region is displayed in a 3D image acquired with an ORTHOPHOS XG 3D!

Views

<table>
<thead>
<tr>
<th>C</th>
<th>Longitudinal view [→ 26]</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Transversal view [→ 28]</td>
</tr>
<tr>
<td>E</td>
<td>Axial plane [→ 29]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>Axial plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>3D view [→ 25]</td>
</tr>
<tr>
<td>C</td>
<td>Coronal plane [→ 30]</td>
</tr>
<tr>
<td>D</td>
<td>Sagittal plane [→ 30]</td>
</tr>
</tbody>
</table>

Plane D

The view D (Default: Sagittal) can be freely adjusted. The name of the "sagittal" plane is changed to reflect the current position.
6.5 "Ceph p.a./a.p." workspace

Scope
This workspace is not available for GALAXIS in connection with model version GAX5.

This workspace is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

Explanation
The Ceph view is calculated from the entire reconstructed volume. Individual thin slices can also be viewed inside the Ceph view with the examination window.

See the section "Reconstructing a p.a./a.p. Ceph view [→ 45]".
### Views

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>3D view [→ 25]</td>
</tr>
<tr>
<td>C</td>
<td>Axial plane</td>
</tr>
<tr>
<td>D</td>
<td>Sagittal plane [→ 30]</td>
</tr>
</tbody>
</table>

### 6.6 "Ceph lateral" workspace

#### Scope

This workspace is not available for GALAXIS in connection with model version GAX5.

This workspace is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

#### Explanation

The Ceph view is calculated from the entire reconstructed volume. Individual thin slices can also be viewed inside the Ceph view with the examination window.

See the section "Reconstructing a lateral Ceph view [→ 47]".
Views

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Ceph lateral</td>
</tr>
<tr>
<td>B</td>
<td>3D view [→ 25]</td>
</tr>
<tr>
<td>C</td>
<td>Axial plane</td>
</tr>
<tr>
<td>D</td>
<td>Coronal plane</td>
</tr>
</tbody>
</table>

6.7 "Detail" workspace

Scope

This workspace is not available for GALAXIS in connection with model version GAX5.

This workspace is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

Explanation

The "Detail" workspace shows an enlarged view of the area inside the examination window.

The voxels are reconstructed and redisplayed with an edge length of 150 µm.

See the section "Creating a detail volume [→ 48]".
Views

<table>
<thead>
<tr>
<th>A</th>
<th>Axial plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>3D view [→ 25]</td>
</tr>
<tr>
<td>C</td>
<td>Coronal plane</td>
</tr>
<tr>
<td>D</td>
<td>Sagittal plane [→ 30]</td>
</tr>
</tbody>
</table>
7 Views

7.1 Panoramic view

Explanation

The panoramic view is reconstructed based on a U-shaped region corresponding to the mandibular arch.

- The examination window [→ 23] is located inside the panoramic view.
- The U-shaped region is displayed in the axial plane of the corresponding workspace.
- The displayed panoramic view can be reconstructed by altering the U-shaped region (see chapter: Reconstructing a panoramic view [→ 39].)

NOTICE

ORTHOPHOS XG 3D only

Only a single region is displayed in a 3D image acquired with an ORTHOPHOS XG 3D!

NOTICE

The subjective image impression of the reconstructed panoramic view is not necessarily comparable to the conventional blurring technique (e.g. ORTHOPHOS) due to the dental volume tomography technique used.

The detail accuracy has been verified by numerous scientific publications.

7.1.1 Examination window

Explanation

The examination window is located inside the panoramic view.

The examination window displays a thin, vertical slice of the volume along the mandibular arch.
Configuration

Position of the examination window is shown by the curved line in the axial slice of the corresponding workspace, as well as by the vertical line in the transversal views and in the longitudinal view.

Move

The examination window can be moved vertically and parallel to the mandibular arch.

1. Place the mouse pointer above the title bar of the examination window.
2. Press and hold down the left mouse button.
3. Move the mouse as desired.

Go to position

A double-click in any position in one of the views (apart from 3D) centers the examination window to this position.

This method is very useful for navigating quickly between different points.

Navigating through slices

You can navigate freely through the slices of the displayed region in the examination window. In this way, the examination window provides access to the third dimension in the panoramic view.

1. Place the mouse pointer inside the examination window.
2. Press and hold down the left mouse button.
3. Move the mouse up and down as desired.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Title bar.</td>
</tr>
<tr>
<td>B</td>
<td>Position of the transversal view (TSA) [→ 28].</td>
</tr>
<tr>
<td>C</td>
<td>Position of the axial plane [→ 29].</td>
</tr>
</tbody>
</table>
• Upward movements of the mouse display the slice positions located further lingual.
• Downward movements of the mouse display the slices located further buccal.

**NOTICE**

*Navigating through slices*

In all views (apart from the 3D view), you can use the mouse to navigate freely through the slices.

This is described in more detail in the following sections.

### 7.2 3D view

**Explanation**

In the 3D view, the volume is displayed as a 3D object.

The 3D view simplifies orientation within the displayed volume.

There is an optimized display for each workspace with a 3D view.

**Configuration**

- The positions of the different slices are displayed as wireframes.
- The currently active slice is highlighted in orange.

#### 7.2.1 3D view in the workspaces

**Panoramic with 3D**
7.2.2 Interaction

Rotate 3D view
1. Place the mouse pointer inside the 3D view.
2. Press and hold down the left mouse button.
3. Move the mouse.
   - You can rotate the 3D view depending on the movement of the mouse.

Set zoom level
1. Place the mouse pointer inside the 3D view.
2. Turn the scroll wheel on the mouse.
   - You can change the zoom level of the 3D view depending on the movement of the scroll wheel.

Move 3D view
1. Place the mouse pointer inside the 3D view.
2. Press and hold down the right mouse button.
3. Move the mouse.
   - You can move the 3D view depending on the movement of the mouse.

7.3 Longitudinal view

Explanation
The longitudinal view is a straight slice oriented longitudinally to the examination window.
This slice can be tilted about the axis of the axial plane.
Configuration

<table>
<thead>
<tr>
<th>A</th>
<th>Longitudinal view</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Axial plane [→ 29]</td>
</tr>
<tr>
<td>C</td>
<td>Slider &quot;tilt&quot;</td>
</tr>
<tr>
<td>D</td>
<td>Reset button &quot;Reset tilt&quot;</td>
</tr>
</tbody>
</table>

**Tilting**

➢ Move the slider with the mouse pointer.

➢ This tilts the longitudinal view.

• A tilted longitudinal view is displayed in the transversal views [→ 28] together with an oblique line.

**Tilt reset**

➢ Press the reset button (D).

➢ The longitudinal view returns to the untilted state.

**Navigating through vertical slices**

You can freely navigate through the vertical slices of the displayed region in the longitudinal view.

1. Place the mouse pointer inside the examination window.
2. Press and hold down the left mouse button.
3. Move the mouse up and down as desired.

• Upward movements of the mouse display the slice positions located further lingual.

• Downward movements of the mouse display the slices located further buccal.
7.4 Transversal view

Explanation

The transverse views are slices that are oriented perpendicular to the mandibular arch.

⚠️ CAUTION

Risk of confusing slices
In GALAXIS the transverse views are always displayed in the direction of view toward the left temporomandibular joint.

Configuration

GALAXIS shows a transversal view underneath the PAN view.

- The middle view corresponds to the transverse view of the vertical line running through the center of the examination window.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Oral/lingual side</td>
</tr>
<tr>
<td>B</td>
<td>Labial/buccal side</td>
</tr>
</tbody>
</table>
Navigating through slices

You can navigate through the transverse views of the displayed region.

The position of the examination window [→ 23] then changes along the mandibular arch.

1. Place the mouse pointer inside a transverse view.
2. Press and hold down the left mouse button.
3. Move the mouse up and down as desired.
   - Upward movements of the mouse display the slices toward the right side of the head.
   - Downward movements of the mouse display the slices toward the left side of the head.
   - This method is used in all 2D slice views in GALAXIS.

7.5 Axial plane

Explanation

The axial plane displays the horizontally positioned slices of the volume at the same height as the horizontal lines shown in the other views.

It is part of the Radiology, Panoramic view with 3D and Panoramic view workspaces.

Setup in the panoramic view

The position of the mandibular arch and of the examination window is shown in the displayed slice.
Navigating through axial slices

You can freely navigate through the axial slices of the displayed region in the axial plane view.

1. Place the mouse pointer inside the axial plane view.
2. Press and hold down the left mouse button.
3. Move the mouse up and down as desired.
   - Upward movements of the mouse display the slice positions located further inferior.
   - Downward movements of the mouse display the slices located further superior.

Orientation

It is possible to adjust the orientation of the axial view (see the section “Settings” [→ 49]).

7.6 Coronal plane

Explanation

The coronal plane displays the frontal slices of the volume and is a component of the Radiology workspace.

- Upward movements of the mouse display the slice positions located further posterior.
- Downward movements of the mouse display the slices located further superior.

7.7 Sagittal plane

Explanation

The sagittal plane displays the frontal slices of the volume and is a component of the Radiology workspace.

Operation

The sagittal plane can be rotated in any direction with the slider.

A button for resetting to the untilted state is located at the bottom left end of the slider.

- Upward movements of the mouse display the slice positions located further to the left.
- Downward movements of the mouse display the slice positions located further to the right.
8 Functions

8.1 2D snapshot

Explanation

With the "2D Screenshot" function, GALAXIS offers the possibility of transferring the current view or the complete current examination to SIDEXIS XG in the form of two-dimensional views.

The views thus transferred can either be added to an existing examination in SIDEXIS XG or to a newly created examination.

Use

The "2D Screenshot" function can be used to document work in the SIDEXIS XG database.

8.1.1 Complete examination

Creating a new exam

➢ Press the "2D Screenshot" button.

or

➢ Go to the "Workspace" menu bar and select the menu option "2D Screenshot"> "Save in new exam".

Adding to an existing exam

➢ Go to the "Workspace" menu bar and select the menu option "2D Screenshot"> "Save in current exam".

Hiding the examination window and auxiliary lines

Explanation

You can use the "Use plain, hi-res grey value images" option to determine whether existing examination windows and orientation lines are shown or hidden when you execute the "2D Screenshot" function.

Activation is indicated by a check mark in front of the "Use plain, hi-res grey value images" menu option.

Activation and deactivation

➢ Use the "Workspace" menu bar to select the "Use plain, hi-res grey value images" menu item.

8.1.2 Individual view

Creating a new exam

➢ Go to the "Image" menu bar and select the menu option "2D Screenshot"> "Save in new exam".

Adding to an existing exam

➢ Go to the "Image" menu bar and select the menu option "2D Screenshot"> "Save in current exam".
Hiding the examination window and auxiliary lines

Explanation

You can use the option “Use plain, hi-res grey value images” to determine whether existing examination windows and orientation lines are shown or hidden when you execute the “2D Screenshot” function. Activation is indicated by a check mark in front of the “Use plain, hi-res grey value images” menu option.

Activation and deactivation

➢ Use the “Image” menu bar to select the “Use plain, hi-res grey value images” menu item.

8.2 Printing

Explanation

With the “Print…” function, GALAXIS offers the possibility of printing either the current view or the complete current examination.

8.2.1 Complete examination

Printout

➢ Press the “Print…” button.

or

➢ Go to the “Workspace” menu bar and select the “Print…” menu option.

Preview

➢ Go to the “Workspace” menu bar and select the “Print Preview…” menu option.

8.2.2 Individual view

Printout

➢ Go to the “Image” menu bar and select the “Print…” menu option.

Preview

➢ Go to the “Image” menu bar and select the “Print Preview…” menu option.

8.3 Navigating through slices

Explanation

In addition to the possibility of navigating through slices directly with the left mouse button, this can also be achieved using the “Navigate into the volume by one slice.” and “Navigate out of the volume by one slice.” buttons.
Navigating into the volume
➢ Press the "Navigate into the volume by one slice." button.
➢ The current view then moves one slice into the volume each time you press the button.

Navigating out of volume
➢ Press the "Navigate out of the volume by one slice." button.
➢ The current view then moves one slice out of the volume each time you press the button.

8.4 Standard mouse pointer

Explanation
The default mode for the mouse pointer is referred to as "Default Cursor".
In this mode, the mouse pointer is displayed as an arrow on the GALAXIS desktop.
The possibilities for changing over from another mode to the "Default Cursor" are described below.

Switching over
Change-over to the "Default Cursor" mode can be performed in the following ways:
➢ Click on the "Default Cursor" button.
or
➢ Use the "Analysis" menu bar to select the "Default Cursor" menu option.
or
➢ Press the space bar on the PC keyboard.

8.5 Mouse adjuster: Adjust brightness and contrast with mouse

Explanation
The so-called mouse adjuster offers a simple and elegant way of adjusting brightness and contrast. It enables you to adjust brightness and contrast simultaneously.

Switching over
Change-over to the "Mouse adjuster" mode can be performed in the following ways:
➢ Use the "Analysis" menu bar to select the "Mouse adjuster" menu item.
or
➢ Hotkey: Activate the key combination "Ctrl" + "Shift" + "M".
Display of the function

As long as this function is active, the mouse pointer in the exam workspace has another shape.

Operation

1. In the exam workspace, press and hold down the left mouse button.
2. Move the mouse as desired.
   - Move it horizontally to change the contrast.
   - Move it vertically to change the brightness.
3. Release the left mouse button when the display settings correspond to your wishes.

You can repeat the adjustment as often as you like from step 1 onwards as long as the mouse adjuster is active.

8.6 Moving the view

Explanation

In some cases, the complete slice plane is longer displayed after the view is enlarged.

Using the "Hand" mode, you can freely move the view as required. Any region of the slice plane can thus be displayed.

Switching over

Change-over to the "Hand" mode can be performed in the following ways:

- Click on the "Hand" button.
- Use the "Analysis" menu bar to select the "Hand" menu option.

8.7 Positioning the crosshair with a single click

Explanation

In certain situations, it is practical to position the crosshair at a specific location with a single click.

Operation

1. Use the "Analysis" menu bar to select the "Crosshair" menu option.
2. Click the desired position in a view.
   - All slices will then be updated to display the selected position according to the slice orientation.
8.8 Resetting the displays

Explanation

If you click the "Back to default" function, all views in all of the displays are reset to their default values.

Affected default values

- Navigating through slices
- Zoom
- Move
- Position of examination window
- Position of 3D view
- Contrast and brightness

Reset

➢ Use the "Analysis" menu bar to select the "Back to default" menu option.

or

➢ Enter [Ctrl] + [r] via the keyboard.

8.9 Measurements

Explanation

GALAXIS offers the following measurement functions:

- Measure lengths [→ 36]
- Measure angles [→ 37]

8.9.1 Measuring lengths

Explanation

This function is used to indicate the distance between two selected points of a view in millimeters.

Measuring accuracy:

- GALILEOS ± 0.15mm
- ORTHOPHOS XG 3D ± 0.1mm

Scope

This measuring function can be used for the following views:

- Longitudinal view
- Transverse view (TSA)
- Axial plane
- Coronal plane
- Sagittal plane
Call method
➢ Click the "Measure Distance" button.
or
➢ Use the "Analysis"/"Measure" menu bar to select the "Measure Distance" menu option.
or
➢ Press the "[D]" key on the PC keyboard.
△ The shape of the mouse pointer then changes to a small cross in the applicable views.

Measurement
1. Place the mouse pointer at the starting point of the measurement.
2. Confirm the starting point by clicking the left mouse button.
3. Drag the mouse pointer to the desired end point.
△ Both points are connected by a line.
4. Confirm the measured length by clicking the left mouse button.

Deletion
1. Mark the measurement with the mouse.
2. Press the Delete key on the PC keyboard.
△ The measurement is deleted.

8.9.2 Measure angles

Explanation
This function is used to indicate the angular relationship between three selected points in a view.
The angle is indicated in degrees.

Scope
This measuring function can be used for the following views:
- Longitudinal view
- Transverse view (TSA)
- Axial plane
- Coronal plane
- Sagittal plane

Call method
➢ Click the "Measure Angle" button.
or
➢ Use the "Analysis"/"Measure" menu bar to select the "Measure Angle" menu option.
or
Press the "[A]" key on the PC keyboard. The shape of the mouse pointer then changes to a small cross in the applicable views.

**Measurement**

1. Move the mouse pointer to the spot where you want to place the apex of the angle.
2. Confirm this position by clicking the left mouse button.
3. Draw the first leg of the angle to be measured using the mouse pointer.
4. Confirm this position by clicking the left mouse button.
5. Draw the second leg of the angle by dragging the mouse pointer.
6. Confirm the angle by clicking the left mouse button.

**Deletion**

1. Mark the measurement with the mouse.
2. Press the Delete key on the PC keyboard. The measurement is deleted.

### 8.9.3 Root canal measurement

**Explanation**

The length can be measured along a path (with max. 20 interpolation points) in the slice views.

Measuring accuracy:
- GALILEOS ± 0.15mm
- ORTHOPHOS XG 3D ± 0.1mm

**Scope**

This measuring function can be used for the following views:
- Longitudinal view
- Transverse view (TSA)
- Axial plane
- Coronal plane
- Sagittal plane

**Call method**

- Click the "Measure along path" button.
- Or
- Use the "Analysis"/"Measure" menu bar to select the "Measure along path" menu option. The shape of the mouse pointer then changes to a small cross in the applicable views.
Measurement

1. Determine the starting point with the mouse pointer.
2. Confirm the starting point by clicking the left mouse button.
3. Drag the mouse pointer to the desired first interpolation point.
4. Confirm this interpolation point by clicking the left mouse button.
5. Repeat steps 3 and 4 until you have reached the desired end point.
   ➥ The length that has just been measured is then extended segment by segment.
6. Confirm the measured length by double-clicking the left mouse button.

<table>
<thead>
<tr>
<th>IMPORTANT</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is not possible to change the view during a path measurement.</td>
</tr>
</tbody>
</table>

Deletion

1. Mark the measurement with the mouse.
2. Press the Delete key on the PC keyboard.
   ➥ The measurement is deleted.

8.10 Reconstructing a panoramic view

Explanation

If the quality of the automatically generated views in the Panoramic view workspace does not meet your diagnostic requirements, you can reconstruct the Panoramic view workspace.

This can be done via the "New Panorama" dialog box.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORTHOPHOS XG 3D only</td>
</tr>
<tr>
<td>Only a single region is available in a 3D image acquired with an ORTHOPHOS XG 3D!</td>
</tr>
</tbody>
</table>

Call method

➤ Press the "Panorama..." button.

or

➤ Use the "Analysis" menu bar to select the "Panorama..." menu option.
   ➥ The "New Panorama" dialog box appears.

Configuration

The central element in the "New Panorama" dialog box is the display of an axial plane of the current volume.
A yellow, U-shaped region (A) which is used to reconstruct the panoramic view is displayed in this axial plane.

Located inside of this region (A) is a blue line (B) which defines the mandibular arch.

**Goal of optimization**

The form, position and size of the U-shaped region (A) are to be optimized in such a way that a higher quality panoramic view is obtained.

**Preview**

A preview of the panoramic view with the current settings is displayed in the lower part of the "New Panorama" dialog box.

The position of the axial slice is indicated in this preview by a yellow line.

**Optimization points**

- The region (A) should include all teeth and the jaw.
- The region (A) should be positioned so that the roots of the teeth are displayed as centrally as possible. Ideally, the blue line of the mandibular arch (B) should run through the center of the roots of the teeth.

**Tools**

**Moving the U-shaped region**

The U-shaped region can be selected and moved.

**Changing the shape of the dentition**

The shape of the dentition (anterior teeth) can be changed via the radio buttons in the "Jaw Shape" dialog box.
Changing the jaw size

The jaw size can be changed via the radio buttons in the "Size" dialog box.

**NOTICE**

In most images, the maximum jaw size returns the best results.

Rotating the U-shaped region

The U-shaped region can be rotated by altering the value entered in the "Turn left/right" input field or by actuating the rotation buttons located next to it.

- This can be helpful if the patient was not optimally positioned during the acquisition of the X-ray image.

Changing the thickness of the U-shaped region

The thickness of the U-shaped region can be defined by changing the value entered in the "Thickness" input field.

**NOTICE**

A thickness of greater than 200% returns the best results in most images.

Resetting the changes made

All of the changes made since the last time the dialog box was opened can be reset by clicking the "Back to default" button.

The "New Panorama" dialog box features tools which simplify editing of the U-shaped region.

Detailed preview

A detailed preview of the current settings can be displayed by clicking the "High quality preview" button.

- This may take several seconds.
- You can thus display the exact results of your settings before closing the dialog box.

Simultaneous display of all axial slices

The "Overlay" function simplifies alignment of the U-shaped region whenever one setting is to be used for both the upper and the lower jaw.

This enables you to obtain an overview of the position of the dentition and of the individual teeth.

- Press the "Superimpose" button.
- The sum of all axial slices will then be displayed.
Resetting the "Superimpose" function

➢ Press the "Single" button.

One axial slice will then be displayed.

Navigating through axial slices

To navigate through the axial slices, proceed as follows:

➢ Press the "Navigate into the volume by one slice." button.

The current view then moves in one slice.

1. Press the "Navigate out of the volume by one slice." button.

The current view then moves one slice out of the volume each time you press the button.

2. Confirm your setting with the "OK" button.

8.11 Zoom function

Explanation

Using the "Zoom in" and "Zoom out" zoom functions, you increase or decrease the magnification of any view.

Magnification

➢ Roll the mouse scroll wheel forward (up).

or

➢ Click the "Zoom in" button.

or

➢ Use the "View"/"Zoom" menu bar to select the "Zoom in" menu option.

Reducing

➢ Roll the mouse scroll wheel back (down).

or

➢ Click the "Zoom out" button.

or

➢ Use the "View"/"Zoom" menu bar to select the "Zoom out" menu option.

8.12 Transfer function

Explanation

The display of the medium shades of gray can be changed via a gamma correction in the transfer function.
Call method

➢ Use the "View" menu bar to select the "Transfer function..." menu option.

_bullet The "Transfer function" dialog box appears.

Operation

1. Move the "Gamma" slider as required.
2. Confirm your setting with the "OK" button.

8.13 Findings-based work

8.13.1 Explanation

Explanation

Findings act as a type of "bookmark" in the volume. When you select a finding, the views are reconstructed in exactly the same way as they appeared when the finding was set.

Display

• Findings that you have created are displayed as a sphere in the volume, or as a circle in 2D slices.
• If you select the finding in a view, the finding is then displayed in the workspace.
• When the finding is selected from the list on the findings toolbar, the entire view is reconstructed. This means that the workspace that was active when the finding was created is selected.

Forwarding findings

It is possible to forward findings that you have created in GALAXIS to colleagues and supervisors:

• Created findings (including all view settings) are saved when a Viewer CD is created and can be displayed in the Viewer (see the section "Creating a GALILEOS Viewer CD" [→ 51]). The user of the Viewer CD then sees the views in exactly the same way as when the findings were created.

• Created findings can be used as a basis for automatically created reports (see the section "Creating a findings report" [→ 45])

8.13.2 Creating a new finding

1. Use the center point of the examination window to navigate to the position at which you want to create a finding.
2. Press the "Insert Finding" button.

_bullet The "Insert Finding" dialog box appears.
3. Enter a name for the finding in the "Title" text box.
4. Enter a description of the region in the "Regio" text box.
5. Enter the finding in the "Finding" text box.
6. Press the "OK" button.
   The finding is saved.

**Options for findings**

Extended options can be set in the "Insert Finding" dialog box (or in the "Finding details" dialog box):

- "Save contrast and brightness with this finding"
- "Save panning and zoom with this finding"

If these options are deactivated, when the finding is focused, the settings are no longer displayed in the same way as they were when the finding was created, but the general settings are retained instead.

### 8.13.3 Selecting a finding

➢ Select the required finding from the list of findings.

or

➢ Select the required finding in the views.

### 8.13.4 Changing the position of a finding

1. Select the appropriate finding.
2. Use the center point of the examination window to navigate to the required position.
3. Press the "Move finding to current position" button.

### 8.13.5 Editing a finding

1. Select the appropriate finding.
2. Press the "Properties" button.
   The "Properties" dialog box appears.
3. Enter a name for the finding in the "Title" text box.
4. Enter a description of the region in the "Regio" text box.
5. Enter the finding in the "Finding" text box.

**NOTICE**

Right-click in the "Finding" field to open a menu containing standard texts for findings. These texts can be changed in SIDEXIS. For more information, refer to the document "SIDEXIS XG / Operator’s Manual" (order number: 59 62 134).
8.13.6 Deleting a finding

1. Select the appropriate finding.
2. Press the "Remove finding..." button.
   The finding is saved.
3. Press the "Yes" button.
   The finding is deleted.

8.13.7 Creating a report

Created findings can be used as a basis for automatically created reports.

As a prerequisite, the relevant current version of the REPORTER software (sold separately) must be installed.

For more information on the REPORTER software, refer to the document "REPORTER / Installation and Operator's Manual" (order no.: 62 59 316).

8.14 Reconstructing a "Ceph p.a./a.p." view

Scope

This function is not available for GALAXIS in connection with model version GAX5.

This function is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

Explanation

If a p.a. or an a.p. Ceph view is required, it can be reconstructed with the "Ceph p.a./a.p. ..." function. The Ceph view is reconstructed from the entire volume.

The starting values for reconstructing the Ceph view can be corrected prior to reconstruction. This can be helpful if the patient was not properly positioned during image acquisition.

Call method

➢ Use the "Analysis" menu bar to select the "Ceph p.a./a.p. ..." menu option.
   The "New Ceph" dialog box appears.

Configuration

The central element in the "New Ceph" dialog box is the display of an axial plane of the current volume.

The initial settings are made via this axial plane.

Preview

A coarse p.a. or a.p. preview of the current settings is displayed in the lower part of the "New Ceph" dialog box.

The position of the axial slice is indicated in this preview by a yellow line.
Selection

The Ceph type (a.p. or p.a.) can be selected via radio buttons in the "Ceph type" dialog box.

Alignment

Rotating the axial plane

The axial slice can be rotated by altering the value entered in the "Turn left/right" input field or by actuating the rotation buttons located next to it.

Tilting the axial plane forward or backward

The axial slice can be tilted horizontally by changing the value entered in the "Nod up/down" input field.

Resetting the changes made

All of the changes made since the last time the dialog box was opened can be reset by clicking the "Back to default" button.

Tools

The "New Ceph" dialog box features tools which simplify editing.

Detailed preview

A detailed preview of the current settings can be displayed by clicking the "High quality preview" button.

- This may take several seconds.
- You can thus display the exact results of your settings before closing the dialog box.

Simultaneous display of all axial slices

This enables you to obtain an overview of the position of the dentition and of the individual teeth.

➢ Press the "Superimpose" button.
➢ The sum of all axial slices will then be displayed.

Reset

➢ Press the "Single" button.
➢ One axial slice will then be displayed.

Navigating through axial slices

To navigate through the axial slices, proceed as follows:

➢ Press the "Navigate into the volume by one slice." button.
➢ The current view then moves in one slice.

➢ Press the "Navigate out of the volume by one slice." button.
➢ The current view then moves in one slice.

Accepting settings

➢ Press the "OK" button.
➢ The "New Ceph" dialog box is then closed and a Ceph view is reconstructed.
8.15 Reconstructing a lateral Ceph view

Scope
This function is not available for GALAXIS in connection with model version GAX5.

This function is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

Explanation
If a lateral Ceph view is required, it can be reconstructed with the "Ceph lateral ..." function. The Ceph view is reconstructed from the entire volume.

The starting values for reconstructing the Ceph view can be corrected prior to reconstruction. This can be helpful if the patient was not properly positioned during the acquisition of the X-ray image.

Call method
➢ Use the "Analysis" menu bar to select the "Ceph lateral ..." menu option.

The "New Ceph" dialog box appears.

Configuration
The central element in the "New Ceph" dialog box is the display of an axial plane of the current volume.

The initial settings are made via this axial plane.

Preview
A coarse lateral preview of the current settings is displayed in the lower part of the "New Ceph" dialog box.

The position of the axial slice is indicated in this preview by a yellow line.

Selection
The Ceph type (LR or RL) can be selected via radio buttons in the "Ceph type" dialog box.

Alignment
Rotating the axial plane
The axial slice can be rotated by altering the value entered in the "Turn left/right" input field or by actuating the rotation buttons located next to it.

Tilting the axial plane to the left or to the right
The axial slice can be tilted to the left or to the right by changing the value entered in the "Tilt left/right" input field.

Resetting the changes made
All of the changes made since the last time the dialog box was opened can be reset by clicking the "Back to default" button.

Tools
The "New Ceph" dialog box features tools which simplify editing.

Detailed preview
A detailed preview of the current settings can be displayed by clicking the "High quality preview" button.
8.16 Creating a detail volume

- This may take several seconds.
- You can thus display the exact results of your settings before closing the dialog box.

Simultaneous display of all axial slices

This enables you to obtain an overview of the position of the dentition and of the individual teeth.

➢ Press the “Superimpose” button.
➢ The sum of all axial slices will then be displayed.

Resetting the “Superimpose” function

➢ Press the “Single” button.
➢ One axial slice will then be displayed.

Navigating through axial slices

To navigate through the axial slices, proceed as follows:

➢ Press the “Navigate into the volume by one slice.” button.
➢ The current view then moves one slice into the volume each time you press the button.

➢ Press the “Navigate out of the volume by one slice.” button.
➢ The current view then moves one slice out of the volume each time you press the button.

Accepting settings

➢ Press the “OK” button.
➢ The “New Ceph” dialog box is then closed and a Ceph view is reconstructed.

8.16 Creating a detail volume

Scope

This function is not available for GALAXIS in connection with model version GAX5.

This function is not available for GALAXIS in connection with ORTHOPHOS XG 3D.

Explanation

If a detail reconstruction is required, one can be produced with the “Close-Up” function.

The “Close-Up” function creates a detail reconstruction from the region displayed inside the examination window.

The region inside the examination window is reconstructed with a voxel size of 150 µm.
Call method

➢ Click on the "Close-Up" button.

or

➢ Use the "Analysis" menu bar to select the "Close-Up" menu option.

The "Close-Up" dialog box appears.

Configuration

The examination window from the panoramic view is displayed in 3 planes (axial, coronal and sagittal).

This is the region of the detail reconstruction to be created.

If the displayed region does not correspond to the desired region, you must close the dialog box and reposition the examination window.

Operation

Assigning names

A name can be assigned to the detail reconstruction in the "Name" input field.

This name will then be displayed on the tab.

If no name is assigned, automatic incrementation will take place.

Accepting settings

➢ Press the "OK" button.

The "Close-Up" dialog box is then closed and a detail reconstruction is produced.

8.17 Showing and hiding orientation lines and findings

Explanation

In the options bar (next to the "Sirona" logo), you can determine whether the orientation lines and findings are displayed or hidden.

To do this, choose the relevant button.

Show/hide orientation lines

This function enables you to show or hide the yellow orientation lines (crosshairs) in the 2D views.

Show/hide findings

This function enables you to show/hide findings in the views. For more information, refer to the section "Findings-based work" [→ 43].

8.18 Settings

Explanation

In the "Customize" menu option, you can make settings that affect how GALAXIS is closed and viewed.
Call method

Use the "View" menu bar to select the "Customize..." menu option.

Operation

*Closing* tab card

When GALAXIS is closed, SIDEXIS XG can transfer the slices displayed in the current workspace to the SIDEXIS database either as individual views or as part of an examination.

The following option fields are available:

- Option button "Automatically make a screenshot and place it in a new exam."
- Option button "Automatically make a screenshot and place it in the current exam."
- Option button "Just close the scan; don't make a screenshot."
- Option button "Prompt me each time I close a scan."

*View* tab card

"Image Quality/Performance" area

- By activating the "This setting is not recommended for less powerful computers, as it can decrease the application's interactivity." check box, the image noise in the view planes can be reduced. In some circumstances, this measure may cause inactivity, since the system requires a considerably greater computing power.
- By activating the "Update all slices continuously when navigating in a given slice." check box, all slice images are continuously updated during navigation. In some circumstances, this measure may cause inactivity, since the system requires a considerably higher computing power.

"Presentation" area

- By activating the "Use thicker lines for display" check box, the lines in the views are displayed thicker (presentation mode).

"Viewing Direction" area

- Here you can select the relevant option field to determine the direction of view of the sagittal and axial slice images.

Accepting settings

➢ Press the "OK" button.
Create GALILEOS Viewer CD

Explanation
You can burn the 3D data to CD together with the panoramic view and the 3D viewer software GALILEOS Viewer.

- The recipient of this GALILEOS Viewer CD can view the image data interactively in 3D without having to install SIDEXIS or GALAXIS.
- GALILEOS Viewer
  The GALILEOS Viewer provides all GALAXIS functions except for a few restrictions (creating detail volumes and saving are not possible).
- As an alternative to burning the data to CD, you can copy the data to a directory or to another medium (e.g. to a USB stick).

NOTICE
The GALILEOS Viewer can also be used to view planes and image data from the GALILEOS Implant software interactively in 3D. However, the data cannot be changed (see also GALILEOS Implant operating instructions).

Open dialog box

➢ Press the "Create viewer CD (Wrap and Go)" button.

or

➢ Go to the "Workspace" menu bar and select the "Create viewer CD (Wrap and Go)" menu option.

The dialog box appears.
Selecting additional files and functions

- "Anonymize patient data" check box
  This function makes the patient data anonymous.
- "Include findings" check box
  This function integrates the list of findings.
- "Attachments" area
  The "Add" button can be used to select additional files (for example a report on the current case in PDF format or a ZIP file with DICOM data).
  - The selected files are displayed in the text field.
  The "Remove" button can be used to remove selected files.

Selecting a function

- "Write to a CD" option button
  You want to create a GALILEOS Viewer CD.
- "Copy this directory" option button
  You want to copy data.
  The "Select directory..." button can be used to select the desired target folder.

Start burn or copy procedure

➢ Press the "Burn CD" button.

- The GALILEOS Viewer CD is created or the data is copied to the selected directory.
We reserve the right to make any alterations which may be required due to technical improvements.